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Abstract

Macropinocytosis serves as an internalization pathway for extracellular fluid and its contents and

is upregulated in oncogene-expressing cells. Recently, we have revealed a functional role for

macropinocytosis in fueling cancer cell growth through the internalization of extracellular

albumin, which is degraded into a usable source of intracellular amino acids. Assessing

macropinocytosis has been challenging in the past due to the lack of reliable assays capable of

quantitatively measuring this uptake mechanism. Here, we describe a protocol for visualizing and

quantifying the extent of macropinocytosis in cancer cells both in culture and in vivo. Using this

approach, the ‘Macropinocytic Index’ of a particular cancer cell line or subcutaneous tumor can be

ascertained within 1–2 days. The protocol can be carried out with multiple samples in parallel and

can be easily adapted for a variety of cell types and xenograft/allograft mouse models.

INTRODUCTION

Macropinocytosis is an endocytic process that mediates the uptake of extracellular fluid into

large intracellular vesicles known as macropinosomes. Macropinosomes are heterogeneous

in size and shape and serve to internalize large volumes of extracellular fluid along with the

associated membrane. This endocytic process is thought to be initiated by the formation of

actin-dependent protrusions of the plasma membrane, known as membrane ruffles. Plasma

membrane contacts between individual ruffles or between a ruffle and the plasma

membrane, followed by membrane fission, results in the formation of a macropinosome. The

newly formed macropinosomes can be targeted to lysosomes or can be recycled back to the

plasma membrane1. Functionally, macropinocytosis plays a role in immunity as antigen-

presenting cells utilize this endocytic process to sample their external environment2.

Additionally, macropinocytosis also represents a cellular route of entry for numerous

bacteria and viruses3,4.

In cancer, macropinocytosis is stimulated by oncogenes, such as Ras5 and Src6–8, and we

have recently linked this form of fluid-phase uptake to cancer cell metabolism and nutrient
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internalization9. The majority of the nutrients required to sustain tumor cell growth are

present in extracellular fluids and approximately 70% of the solubilized substances are

proteins, with serum albumin being the most abundant. We determined that oncogene-

stimulated macropinocytosis is an entry route for extracellular albumin. In this context, the

internalized albumin is subsequently targeted for lysosomal degradation, releasing the

constituent amino acids, which then have the capacity to support the metabolic and

biosynthetic needs of the tumor cells. Therefore, macropinocytosis is an important nutrient

delivery pathway that cancer cells use to drive their proliferation and growth.

Methods to detect and quantify macropinocytosis

We have developed and optimized techniques for detecting and quantifying

macropinocytosis both in vitro and in vivo. Our protocol is based on the incorporation of

fluorescently-labeled, lysine-fixable, 70 kDa high molecular weight dextran from the

extracellular medium into large, discrete macropinosomes, which can be visualized

microscopically as fluorescent intracellular puncta. Using these techniques, the extent of

macropinocytosis, or what we have termed the ‘Macropinocytic Index’, for a particular

cancer cell line or subcutaneous tumor can be determined. Specifically, the macropinocytic

index is a two-dimensional parameter that quantifies the percentage of cell area occupied by

dextran-positive macropinocytic compartments within a given timeframe of dextran uptake.

At the cellular level, the macropinocytic index is a read-out of not only macropinocytic rate,

but also of macropinosome size. Ascertaining the macropinocytic index of a particular cell

line or tumor has the potential to shed light on the metabolic properties of the sample. For

example, if a tumor exhibits a high macropinocytic index, then this may be an indication that

the tumor relies on macropinocytosis for its growth and survival. Indeed, we found that the

inhibition of macropinocytosis in tumors with a high macropinocytic index selectively leads

to a decrease in tumor growth in a xenograft mouse model of pancreatic cancer9.

Macropinocytosis has also been studied in the context of drug delivery and has been

implicated as a delivery mechanism for a number of therapeutics including cell penetrating

peptides, nanoparticles, and microbe-based biotherapies10–12. Therefore, the macropinocytic

index may represent a predictive biomarker in the effective usage of these forms of cancer

therapy.

The quantification of macropinocytosis can be achieved through either microscopic or non-

microscopic methods. For microscopic methods, macropinocytosis is fluorescently

visualized and quantified in either fixed or live cells. The protocol described herein

illustrates the microscopic visualization and quantification of macropinosomes in fixed cells

via image-based analysis in ImageJ. Previous reports have described methods for

quantifying macropinocytosis in fixed sample. The quantification method utilized by Haga,

et al.13 depends on subjective categorization (i.e. qualitatively assigning cells into low to

high macropinocytosis categories). The method developed by Wang, et al.14 is similar to our

protocol in that it can be applied to any cell monolayer; however, their procedure involves

an additional step to consider only transfected cells. Our protocol has wide applicability to

both cultured cells and xenograft tumor models. A particular consideration of our protocol is

that the method requires fixed samples. Hence, the analysis captures a snapshot of the

process rather than the dynamic nature of macropinocytosis in real time. A quantification
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method entailing the imaging of macropinocytosis in live cells through phase contrast

microscopy and observing the phase-bright macropinosomes that emerge downstream of

membrane ruffles has been recently reported15. However, this method lacks the selectivity

provided by a fluorescent macropinocytosis marker and is limited to the analysis of cultured

cells, precluding the analysis of macropinocytosis in xenograft tumors.

For non-microscopic methods, the most commonly reported macropinocytosis assay

involves uptake of the soluble enzyme Horseradish peroxidase (HRP). Quantification in this

procedure measures HRP enzymatic activity in cell lysates derived from cells that have

internalized the enzyme16. This approach is suitable for quantifying macropinocytosis across

multiple conditions or cell lines; however, this method does not provide any visual

confirmation of the process nor does it provide structural information in the manner that

image-based procedures do. Moreover, it is unclear how specific an HRP uptake assay is

considering the extent that HRP adheres to the cell surface17. A second non-microscopy-

based quantitative method for the analysis of macropinocytosis utilizes Flow Activated Cell

Sorting (FACS)18. For this approach, cells are pulsed with fluorescently labeled dextran,

cells are washed, trypsinized, and fixed, and dextran uptake is subsequently quantified via

FACS. While this method allows for robust quantification of macropinocytosis on a sample

by sample basis, it does not provide any structural information on a cellular level.

Furthermore, the temperature and time required for the trypsinization step, which is

necessary to create the cell suspensions for FACS analysis, are not optimal; hence our

protocol takes advantage of a low temperature incubation immediately following the uptake

step, which introduces a blockade in trafficking events, allowing for the maximal retention

of the internalized dextran19.

EXPERIMENTAL DESIGN

Choice of cell lines

The protocol described herein was optimized for use in the human pancreatic

adenocarcinoma cell lines, MIA PaCa-2 and BxPC-3. However, the protocol has been very

easily adapted to other cell lines taking into account some important considerations.

Optimization of our procedure has been performed using moderate cell confluence

conditions (~75% confluent). Thus, cell lines that require either sparse growth conditions or

maintenance as a confluent sheet may require further optimization. The procedure involves

several washing steps prior to fixation; therefore, the cell lines used should be readily

adherent to cover glass to ensure that they are not displaced during the washes. To

circumvent poor adhesion to the cover glass, the cover glass could be coated with an

extracellular matrix protein to increase cell adherence; however how this would affect usage

of our procedure would have to be determined. Additionally, this protocol has been

optimized to assess levels of macropinocytosis that occur under serum-starved conditions.

Serum starvation was employed to distinguish the inherent levels of macropinocytosis

within the cell lines analyzed from the non-autonomous effects on macropinocytosis exerted

by the growth factors present in serum-supplemented media. However, this protocol can be

adapted to assay cells in serum- or growth factor-supplemented media by further optimizing

the concentration and incubation time of the fluorescent dextran.
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Choice of dextran conjugate

We have optimized the described assays for use with fixable 70 kDa dextran that has been

conjugated with either fluorescein isothiocyanate (FITC) or tetramethlyrhodamine (TMR).

However, our preference for the assay is the TMR conjugate because, unlike FITC, it is

generally insensitive to the low pH attained by the macropinosome as it matures20. We have

utilized 70 kDa molecular weight dextrans to label macropinosomes because the

macropinosomes labeled by these dextrans fall within the classically defined size range of

0.2–10 μm in diameter21. These high molecular weight dextrans are selectively internalized

into macropinosomes whereas lower molecular weight dextrans show less fidelity in their

internalization and may label other endocytic pathways22. Depending on the timing of

trafficking events in the particular cell line or tumor being analyzed, it is possible that the

macropinocytosed dextran may label other endocytic compartments, such as endosomes that

have fused with macropinosomes downstream of internalization. Therefore, if the

macropinocytic contents are rapidly targeted to the endosome system or the lower molecular

weight dextrans must be employed, then a shorter dextran incubation time and the diameter

of the labeled macropinosomes should be taken into consideration when quantifying the

results.

Analysing xenografts

For determining the macropinocytic index of xenograft tumors, the tumors can be generated

using established procedures, such as the protocol developed by Kim et al.23 The in vivo

methodology in our protocol has been designed to be utilized in the study of subcutaneous

heterotopic human pancreatic cancer xenografts in immunodeficient mice. However, it can

be easily adapted to other heterotopic organ models and to heterotopic allograft tumors. For

computing the macropinocytic index of subcutaneous tumors, immunological staining of the

tissue with an antibody that selectively labels the tumor cells is necessary to ensure that the

macropinosomes visualized are a feature of the transplanted cells rather than the host cells.

In pancreatic tumor xenografts, we have successfully used anti-cytokeratin 8 staining to

specifically label the human pancreatic epithelial cells within the tumor9. Therefore, to adapt

this protocol to other subcutaneous tumors, a tumor cell-specific marker must be identified

prior to analysis.

Controls

In addition to their large size and the ability to internalize high molecular weight dextran,

macropinosomes are also defined by their unique sensitivity to amiloride and its derivatives,

a class of Na+/H+ exchange inhibitors21. Amilorides inhibit macropinocytosis by lowering

the submembranous pH, which in turn interferes with the actin remodeling that is required

for plasma membrane ruffling24. Therefore, in order to further validate macropinocytosis-

specific uptake, an important experimental control in the analysis of macropinocytosis is to

evaluate the effects of amiloride treatment. Treatment with the amiloride derivative 5-(N-

ethyl-N-isopropyl) amiloride (EIPA) is the most effective and selective method currently

used to pharmacologically inhibit macropinocytosis25. For cell culture experiments, the dose

of EIPA required to inhibit macropinocytosis must be empirically determined; however, we

have observed robust inhibition typically in the range of 25 to 100 μM. It should be noted
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that EIPA doses at the higher end of this range tend to be cytotoxic to a subset of cell lines

and whether this is the case for a particular cell line of interest must be determined. To

validate the specificity of EIPA in a cell line of interest, the effects of EIPA treatment on

clathrin-mediated endocytosis can be assessed by performing a transferrin uptake assay26.

At high doses, EIPA may exhibit autofluorescence when imaging using a filter set for

collecting blue or green wavelength fluorescence; therefore we recommend the use of TMR-

Dextran with EIPA treatment as opposed to FITC-Dextran, whenever possible. Furthermore,

EIPA autoflourescence may appear when DAPI images are collected, thus it is advised to

use short exposure times to collect DAPI images in EIPA treated cells to minimize this

effect. To inhibit macropinocytosis in vivo, we have successfully employed osmotic pumps

(Alzet) implanted subcutaneously in mice to systemically deliver EIPA at a steady dose over

the course of a 3–7 day experiment9. Such a delivery mode is advantageous because of the

short half-life of EIPA once exposed to circulating plasma27. An additional control,

especially in the case of a low macropinocytic index, is to simultaneously assess

macropinocytosis in a cell line expressing an oncogenic form of Ras. This can be achieved

by transfection of oncogenic Ras into the particular cell line of interest or by using an

oncogenic Ras-expressing cell line that has been established to have a high macropinocytic

index, such as MIA PaCa-2, T24 or NIH 3T3 KRasV12 cells9.

MATERIALS

REAGENTS

• Cell line or xenograft to be analysed plus appropriate controls. CRITICAL See

Experimental Design section for further guidance. CAUTION Experiments using

live rodents must conform to Institutional and National regulations.

• DMEM (Gibco, cat. no. 11965-092)

• RPMI (Gibco, cat. no. 11875-093)

• Sodium Pyruvate (Mediatech Cellgro, cat. no. 25-000-CI)

• HEPES (Corning Cellgro, cat. no. 25-060-CI)

• 1% Penicillin/Streptomycin (Gibco, cat. no. 15140-122)

• Fetal Bovine Serum (FBS, Gibco, cat. no. 10438-026)

• Trypsin-EDTA (Gibco, cat. no. 25200-056)

• 1 M HCl (Sigma, cat no. 7647-01-0)

• 70 kDa TMR-Dextran, lysine fixable (Invitrogen Molecular Probes, cat. no.

D1818)

• 70 kDa FITC-Dextran, lysine fixable (Invitrogen Molecular Probes, cat. no.

D1822)

• 5-(N-ethyl-N-isopropyl) amiloride (EIPA) (Invitrogen Molecular Probes, cat. no.

e-3111)

• PBS (Gibco, cat. no. 14190)
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• 4’,6-Diamidine-2’-phenylindole dihydrochloride (DAPI) (Sigma, cat. no. D9542)

• DAKO fluorescent Mounting Media (DAKO, cat. no. S3023)

• 37% ACS reagent grade Formaldehyde Solution (Ricca Chemical Company, cat.

no. 50-00-0)

• O.C.T. Compound (Tissue-Tek, cat. no. 4583)

• Normal Chicken Serum (Jackson ImmunoResearch, cat no. 003-000-001)

• Albumin from bovine serum (BSA, Sigma-Aldrich, cat no. A7906)

• Troma I Antibody (recognizes Cytokeratin-8, Developmental Studies Hybridoma

Bank)

• Alexa Fluor 594 Chicken Anti-Rat IgG (Molecular Probes, cat no. A-2147)

• Dry ice

• Athymic mice (Taconic NCRNU, homozygous)

EQUIPMENT

• 37°C/5% CO2 cell culture incubator

• Vacuum aspirator

• 12 mm (0.13–0.17 mm thick) circular cover glass (Fisherbrand, cat no. 12-545-80)

• Zeiss Axiovert inverted 200M wide-field microscope equipped with a 63X 1.4 NA

Phase objective, filter sets for DAPI, FITC, and Rhodamine, and a CCD camera

• 1 cc 28G ½ inch insulin syringe (Becton Dickinson, cat no. 329410)

• Standard dissection tools

• Microtome cryostat

• 24 well plates (Becton Dickinson Falcon, cat no. 353047)

• Cryomold (Tissue-Tek Cryomold, cat no. 4557)

• 3x1 inch (0.93–1.05 mm thick) glass slides (Becton Dickinson Gold Seal, cat no.

3010)

• Forceps

• Digital calipers (Fisher World Precision, cat no. 111–100)

• Liquid blocker pen (Daido Sangyo Co, Super PAP Pen)

• 24x50 mm rectangular cover glass (VWR, cat no. 48393081)

• High-Density Polyethylene Staining Jar (Sigma, S5641)

• Image J software (http://imagej.nih.gov/ij/)
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REAGENT SETUP

CRITICAL All solutions and buffers must be free of detergent and therefore should be

prepared in glassware thoroughly cleaned with ethanol or new plasticware. All solutions

containing cell culture media should be pre-warmed to 37°C prior to usage. Prepared media

containing FBS can be stored at 4°C for 1–2 weeks.

MIA PaCa-2 complete media—This media consists of DMEM supplemented with 10%

(vol/vol) FBS, 25 mM HEPES, and 100 U/ml Penicillin/Streptomycin.

MIA PaCa-2 serum-free media—This media consists of DMEM supplemented with 25

mM HEPES and 100 U/ml Penicillin/Streptomycin.

BxPC-3 complete media—This media consists of RPMI supplemented with 10% (vol/

vol) FBS, 25 mM HEPES, 1 mM Sodium Pyruvate, and 100 U/ml Penicillin/Streptomycin.

BxPC-3 serum-free media—This media consists of RPMI supplemented with 25 mM

HEPES, 1 mM Sodium Pyruvate, and 100 U/ml Penicillin/Streptomycin.

Dextran stock solution Dissolve—25 mg of fluorescently labeled 70 kDa fixable

dextran in 1.25 mL of PBS to give a 20 mg/ml Dextran final concentration. Store 100 μL

aliquots of this stock in the dark at −20°C.

CRITICAL Ensure that the dextran is completely dissolved by pipetting up and down.

Incomplete solubilization will negatively affect downstream microscopic visualization.

Dextran cell culture incubation media—Dilute the Dextran stock solution to 1 mg/ml

final concentration in the appropriate serum-free medium.

CRITICAL The dextran cell culture incubation media should be prepared on the day of the

experiment.

Fixation buffer Dilute—37% ACS reagent grade Formaldehyde Solution in PBS to a

final concentration of 3.7% (v/v). CRITICAL Freshly prepare the solution on the day of the

experiment.

DAPI stock solution Dissolve—5 mg of DAPI in 0.5 mL of ddH20 to a final

concentration of 10 mg/ml. Store 5 μL aliquots at −20°C.

DAPI solution Dilute—one 5 μL aliquot of DAPI stock solution with 495 μL of ddH20

and stored at -20°C.

DAPI staining buffer—Dilute DAPI solution 1:100 in PBS.

CRITICAL The DAPI staining buffer should be prepared on the day of the experiment.

CAUTION DAPI is a carcinogen; avoid contact with skin.
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Normal Chicken Serum—Resuspend the freeze-dried chicken serum in 2 mL PBS. Can

be aliquoted and stored at -20°C.

Blocking solution—10% Normal Chicken Serum (v/v) and 2% BSA (w/v) prepared in

PBS. CRITICAL Freshly prepare the solution on the day of the experiment.

Primary antibody solution—Dilute Troma-I antibody 1:250 in Blocking solution.

CRITICAL Freshly prepare the solution on the day of the experiment.

Secondary antibody solution—Dilute Alexa Fluor 594 Chicken Anti-Rat antibody

1:500 in Blocking solution. CRITICAL Freshly prepare the solution on the day of the

experiment.

EQUIPMENT SETUP

• Circular Cover Glass Heat cover slips in a covered glass beaker in 1M HCl at

50°C for 24–48h. Cool them to room temperature (22.5°C) and rinse four times

with ddH2O. Rinse four times with 95% EtOH and store in 95% EtOH at room

temperature.

• Epifluorescence microscopy setup Our setup consists of a Zeiss Axiovert inverted

200M fluorescence microscope (Carl Zeiss AG) equipped with a 63X 1.4 NA

Phase oil objective and a CCD camera (1388 X 1040 Axiocam MR Rev3, Zeiss).

DAPI (absorption/emission maxima ~358/461) is detected with the excitation filter

365/50, the 395 beamsplitter and the emission filter 445/25. The FITC-dextran

fluorescence (absorption/emission maxima ~ 494/521) is detected with the

excitation filter 485/10, the 510 beamsplitter and the emission filter 540/25. TMR-

Dextran (absorption/emission maxima ~ 555/580) or secondary antibody

conjugated Alexa fluor 594 (absorption/emission maxima ~590/617) is detected

with the excitation filter 545/15, the 570 long pass beamsplitter and the emission

filter 620/30.

PROCEDURE

Labeling of macropinosomes

1 The visualization of macropinosomes in tumor cells, either in cell culture

conditions (option A) or in vivo (option B), is based on the ability of cells to

internalize extracellular fluid containing fluorescently-tagged 70 kDa high

molecular weight dextran, an established marker of macropinocytosis. Option A

requires the addition of either FITC-dextran or TMR-dextran to the culture

medium and is applicable to any adherent cell line. Option B involves the

intratumoral injection of FITC-dextran into subcutaneous xenograft tumors in

immunodeficient mice and can be employed to detect macropinosomes in

tumors derived from any cancer cell line. For option B, the protocol is described

for FITC-dextran; however, TMR-dextran can be just as effectively utilized, but

it must be ensured that the fluorescent secondary antibodies that are
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subsequently used are compatible for microscopic analysis (i.e. are not imaged

on the same channel).

(A) Labeling of macropinosomes in cultured cells—Timing 2–4 days

i. Working in a sterile cell culture hood, place a circular cover glass into each well of

a 24-well tissue culture plate, as required, and rinse 3 times in PBS.

ii. Split cell line(s) of interest in complete media into wells containing the circular

cover glass. The optimal cell density should be such that the cells will be 60–70%

confluent within 2–3 days post-seeding.

iii. When cells reach ~65% confluency, remove complete growth media and incubate

the cells in the appropriate serum-free media for 12–16 hours.

iv. Replace serum-free media on cells with Dextran cell culture incubation media.

Incubate in a 37°C/5% CO2 cell culture incubator for 30 min.

v. Place 24-well plate containing cells on ice and carefully aspirate media from each

well. Gently wash each well with 2 mL of ice cold PBS for a total of 5 washes.

CRITICAL STEP Ensure complete rinsing of the samples, as insufficient washing

will yield high levels of fluorescent background and negatively impact downstream

microscopic visualization.

B. Labeling of macropinosomes in xenograft tumors—Timing 3–5 weeks.

i. Establish xenograft tumors in the flanks of 4 week old female nude athymic mice

(NCr-Foxn1nu) using the appropriate protocol that is in accordance with relevant

guidelines and regulations specific to your institution. Refer to an existing protocol

for details, such as that by Morton and Houghton28. Allow subcutaneous tumors to

attain an average volume of 300–500 mm3.

ii. Place the tumor-bearing athymic mouse into the anesthesia chamber following the

manufacturer's recommended settings. After the mouse is sufficiently anesthetized,

remove it from the chamber and place it (ventral side down) in an appropriately-

sized nose cone, configured according to the manufacturer's recommended settings.

iii. Use a 1 cc 28G ½ inch insulin syringe to inject 100 μL of the Dextran stock

solution (FITC-dextran) directly into the tumor.

CRITICAL STEP Ensure that the needle has entered the tumor mass prior to

expulsion of the dextran stock solution. For stiff tumors, it is imperative to inject

the dextran solution as slowly as possible. If properly injected, the tumor should

have a slight yellow coloring due to the fluorescent moiety of the dextran. If the

dextran is inadvertently injected subcutaneously, then coloration is visualized in the

flank of the mouse instead, indicating a failed dextran injection and the tumor

should be re-injected.

iv. Place the animal in a clean cage and observe for 10–15 min to ensure recovery

from the anesthetic.
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v. 30–60 minutes post-dextran injection, euthanize the mouse in accordance with

relevant guidelines and regulations. We use a CO2 euthanasia chamber with a

stainless steel cover with the tube attached to the CO2 regulator. CO2 at a low flow

rate (20% of the chamber volume per minute) is recommended. Low flow rate of

CO2 should be maintained until the animals become unconscious, then the flow rate

can be increased to minimize the time to death (maximum of 5 minutes). The flow

should be maintained for at least 1 minute after apparent clinical death. They

should remain in the chamber or cage until absence of respiration and heartbeat is

observed. Animals are removed from the chamber and cervical dislocation is

performed to confirm death

vi. Immediately dissect the tumor and place in a cryomold containing O.C.T.

Compound. Ensure that the tumor is completely covered by the O.C.T. Compound

and place the cryomold atop dry ice. Once completely frozen (10–15 min), store the

sample at −80°C for at least 24 hours.

PAUSE POINT The sample can be frozen for up to 6 months at −80°C.

Processing the samples

2 This step of the protocol is composed of processing the cells or tissue samples in

preparation for microscopic analysis. Option A describes the procedure utilized

to process the cell culture samples, while Option B outlines the methodology

used to process the frozen tumor specimens.

A. Processing cell culture samples—Timing 1 day

i. Add Fixation buffer to the cells for 30 min at room temperature.

ii. Rinse cells 3 times with PBS.

iii. Incubate cells in DAPI staining solution for 15 minutes at room temperature.

CAUTION DAPI is a carcinogen; avoid skin contact.

iv. Rinse cells 3 times with PBS.

v. Apply one drop of DAKO mounting media to glass slide. Lift cover glass from

wells using forceps and gently place cover glass on top of DAKO cell-side down.

vi. Store freshly mounted slides on a flat surface in the dark for 12–18 hours, allowing

them to dry.

CRITICAL STEP Fluorescent dextrans are light sensitive; therefore, it is

imperative to protect the slides from light as much as possible.

PAUSE POINT Once dry, slides can be stored for up to 2 weeks at −20°C.

B. Processing of frozen tumors samples—Timing 1 day

i. Slice the still frozen tissue using a microtome, and mount the frozen sections on a

glass slide. Store these slides at −80°C.
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PAUSE POINT The frozen slides can be stored for up to 3 months at −80°C.

ii. Place the slides flat (tissue section side up) in an opaque container. Air-dry the

slides at room temperature for 15 min, preferably in an air circulation hood with the

top of the container slightly ajar.

CRITICAL STEP Fluorescent dextrans are light sensitive; therefore, it is

imperative to protect the slides from light as much as possible.

iii. Add 50 mL of fixation buffer to an opaque polypropylene staining jar. To a

separate jar, add 50 mL PBS. Place the slides into the jar of PBS and incubate for

30 seconds. Lift and dip each slide five times rapidly into the PBS and immediately

transfer to the jar containing the fixation buffer. Incubate at room temperature for

15 min.

CRITICAL STEP Rinsing the slides in PBS immediately prior to fixation helps

reduce nonspecific background caused by the fluorescent dextran.

CRITICAL STEP After fixation, do not allow the slides to dry out.

iv. Move the slides to a clean staining jar containing PBS. Incubate for 3 min.

v. For each slide, use a liquid blocker hydrophobic pen to draw a circle around the

tissue section allowing several millimeters of space between the liquid blocker and

the tissue. Place the slide into a clean staining jar containing PBS. Incubate for 3

min.

vi. Perform one additional PBS wash as above.

vii. Place each slide flat (tissue section side up) in an opaque container. Carefully add

100 μL of Blocking solution directly to the tissue section. The liquid blocker

encircling the sample will prevent spreading of the blocking solution. Place the

cover on the container. Incubate at room temperature for 1 hr.

CRITICAL STEP Conventional staining techniques often include a detergent-

based permeabilization step. Do not use any detergents when analyzing dextran-

containing macropinosomes, as tissue permeabilization substantially decreases

macropinosome labeling.

viii. Remove the blocking solution from the slide by gently tapping the slide onto a

paper towel. Carefully add 100 μL of primary antibody solution to the tissue

section. Incubate for 1 hr at room temperature.

CRITICAL STEP This protocol has been optimized for the Troma I antibody and

the dilution factor for your tumor cell-specific antibody may vary and must be

empirically determined.

ix. Remove the primary antibody solution from the slides by gently tapping onto a

paper towel and move the slides to a staining jar containing 50 mL of PBS. Perform

3 PBS washes (5 min each) in clean staining jars.
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x. Place each slide flat (tissue section side up) in an opaque container. Carefully add

100 μL of secondary antibody solution to the tissue sample. Incubate at room

temperature for one hour.

xi. Remove the secondary antibody solution from the slides by gently tapping onto a

paper towel and move the slides to a staining jar containing 50 mL of PBS. Perform

3 PBS washes (5 min each) in clean staining jars.

xii. Place each slide flat in an opaque container. For nuclear staining, add 100 μL of

DAPI staining buffer to the tissue section. Incubate at room temperature for 15 min.

CAUTION DAPI is a carcinogen; avoid contact with skin.

xiii. Remove the DAPI staining buffer from the slides by gently tapping onto a paper

towel and move the slides to a staining jar containing 50 mL of PBS. Perform 3

PBS washes (5 min each) in clean staining jars.

xiv. Remove excess PBS from the slide using a Kimwipe. Place the slide on a flat

surface and add one or two drops of DAKO mounting medium directly to the tissue

section. Immediately place a rectangular micro cover glass gently on top of the

sample. The mounting medium should spread to the edges of the cover glass. If it

does not, gently tap the cover glass.

xv. Dry slides in the dark at room temperature for 18 hours.

PAUSE POINT Stained slides can be can be stored for up to 2 weeks at −20°C.

Capturing images and data analysis

Timing 30 min to 1 hour per individual replicate sample (10 fields)

3 Perform image acquisition. We utilize an Axiovert 200 inverted fluorescent

microscope (Zeiss) equipped for phase contrast and with a standard optical filter

set including DAPI, FITC and Rhodamine. Capture images using a 63X phase

objective and the AxioVision software platform. Prior to capturing images, use

the automated exposure time feature to determine the approximate exposure

time to be applied to all the samples for each individual channel being analyzed.

Typically, the FITC and Rhodamine exposure times range from 100–1000 ms

and manually setting the exposure time lower than the automated exposure time

can ensure that the images are not overexposed. To ensure reliability of

downstream quantification, obtain at least 10–20 random fields for every sample

or tissue section.

CRITICAL STEP To fairly evaluate the extent of macropinocytosis across

various cell culture samples, it is necessary to utilize the same exposure time for

every sample and to capture random images.

4 Save the images in ZVI format. TIFF format can also be used.

5 Select an image from your collection that visually contains bright, discrete

macropinocytic puncta. Load the ZVI file into Image J. There should be separate

images for each acquired channel of the image.
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6 Duplicate the image containing the labeled macropinosomes using the

Image>Duplicate function. Tile the images side-by-side. One of the images will

be used as a reference image and the other will be processed.

7 Perform a background subtraction on the image to be processed by selecting

Process>Subtract Background. Set the rolling ball radius to 5 pixels. If any other

options are selected with a check mark, unselect them.

8 To adjust the thresholds of the image, select Image>Adjust>Threshold. To

optimize the threshold settings such that the macropinosomes are specifically

selected, select “Dark background” and click the “Auto” button. If, by

comparing to the reference image, all of the macropinosomes are covered with a

red threshold signal, then the reference image may be closed and the threshold

value recorded. This recorded threshold value is the threshold to be set for all

the images. Select “Apply.”

CRITICAL STEP For images with low fluorescent signal or high background

fluorescence, it may be necessary to manually set the threshold values to detect

the macropinosomes. To do this, set the top threshold sliding bar just to the right

of the peak count value. Use the reference image to ensure the accuracy of the

threshold adjustment.

9 Compute the ‘Macropinocytic Index’ of the sample by determining the total

macropinosome area in relation to the total cell area for each field (‘Field

Index’) and then determining the average across all the fields. Calculate the

‘Total Cell Area’ parameter for the in vitro setting with a phase contrast image

as described in Option A or in the xenograft tumor setting from images obtained

by counterstaining sections with a tumor-cell specific marker as described in

Option B.

A. Determining the ‘Total Cell Area’ for a cell monolayer

i. To determine the ‘Total Cell Area’ in ImageJ, click on the phase contrast image.

Select the “Polygon selections” tool. Use the polygon tool to outline the regions of

the image that are covered by cells and then select Analyze>Measure to determine

the area of each region. Record the value for the “Area” parameter. If there is more

than one region per image, then sum the regions to obtain ‘Total Cell Area.’

B. Determining the ‘Total Cell Area’ for a xenograft tumor

i. To determine the ‘Total Cell Area’ in ImageJ, click on the image displaying the

immunostaining for the tumor-cell specific marker. Select the “Polygon selections”

tool and outline the areas of the image containing tumor-cell specific fluorescence.

Determine the area of the field covered by tumor cells by selecting

Analyze>Measure. Record the “Area” parameter. This is the ‘Total Cell Area’ for

the field.

10 Next, overlay the polygon-shaped selection onto the thresholded binary image

containing the macropinosomes. Do this by clicking on the binary image and
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selecting Edit>Selection>Restore Selection. Compute the area of the

macropinosomes within the selection by selecting the Analyze>Analyze

Particles feature. Keep the default settings for Size (0-Infinity) and Circularity

(0.00–1.00). The boxes for “Clear results” and “Summarize” should be selected.

Click “OK.” Several parameters are displayed. Record the “Area” for this

image. If there are multiple cell area selections, then repeat this for each unique

polygonal selection. This is the ‘Total Particle Area’ for the field.

11 To compute the ‘Field Index’ for each field, divide the ‘Total Particle Area’ by

the ‘Total Cell Area’ and multiply by 100. Repeat this procedure for all the

images originating from the sample and compute the ‘Macropinocytic Index’ of

the sample by averaging the ‘Field Index’ column.

TIMING

Steps 1A and 2A, labeling macropinosomes in cultured cells and processing samples:

2–4 days for cell culture + 3 hours labeling macropinosomes and processing samples +

12–18 hours coverglass bonding to slides prior to imaging.

Steps 1B and 2B, labeling macropinosomes in xenograft tumors and processing

samples: 3–5 weeks establishing xenograft tumors + 3 hours labeling macropinosomes

and tumor dissection + 3 days processing samples

Steps 3–10, capturing images and data analysis: 4–12 hours

TROUBLESHOOTING

Troubleshooting advice can be found in Table 1.

ANTICIPATED RESULTS

The image-based assays described herein allow for the visualization and quantification of

macropinosomes in vitro, as well as in tumor xenografts in vivo. Because our experimental

setup relies on signal thresholding, it is imperative to capture random images from one set of

experiments at the same exposure times, which can vary from experiment to experiment, in

the same imaging session. In our experience, the best method of determining the optimal

exposure time is to utilize the automated exposure feature available with all imaging

platforms on an experimental sample that visually exhibits a high level of macropinocytosis.

This will allow for an accurate assessment of macropinocytosis when setting the threshold

value in the ImageJ software.

As an example of the in vitro implementation of this protocol, we have assessed the extent

of macropinocytosis in two pancreatic cancer cell lines. Sample images from the various

steps of quantification are shown in Figure 1. The DAPI channel is utilized to visualize the

number of cells and using a 63X objective lens, a typical field may contain 20–40 cells,

depending on the confluence of the cells. The phase contrast image allows for the

determination of cell area, which is outlined in yellow. For demonstrative purposes, we

compared the extent of macropinocytosis in MIA PaCa-2 and BxPC-3 cells, cell lines that

we have previously established to have a high and low macropinocytic index, respectively.
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Images depicting TMR-dextran fluorescence from representative fields for each cell line are

shown. The threshold value for this particular experiment was determined by utilizing the

automated threshold feature of ImageJ for one of the MIA PaCa-2 images and this threshold

value was then applied to all the images in the experiment. In the threshold image, TMR-

positive macropinosomes are identified by the software and colored red. Once the threshold

is applied, the result is a binary image, which is then analyzed using the analyze particles

feature. The process is repeated for each image, and the total particle area and total cell area

is then recorded and tabulated as shown in Table 2. For simplicity, we multiply the “Field

Index” values by 100. To successfully employ this protocol for cell monolayers, we

recommend analyzing between 200 and 300 cells, which typically consists of 10–20 fields.

The macropinocytic index values for cancer cell lines typically range from 0 to 0.5 for low

macropinocytic cells and are >1 for highly macropinocytic cells. These values can vary by

up to 20% from experiment to experiment, which can be improved by increasing the sample

size, and we typically observe an average variation between 5–10% from experiment to

experiment. When analyzing several cell lines or different conditions, the macropinocytic

index can be displayed graphically using the raw or relative values.

To demonstrate the in vivo quantification of macropinocytosis we have evaluated the extent

of FITC-dextran uptake in tumor xenografts derived from either MIA PaCa-2 or BxPC-3

cells. In these tumors, the pancreatic epithelial cells are labeled by cytokeratin-8 staining in

order to differentiate them from the mouse host cells, such as fibroblasts and immune cells,

which may infiltrate the tumor (Figure 2). This cytokeratin-8 staining is utilized to compute

the total area occupied by the tumor cells in each field. The thresholding procedure used to

identify and quantify the FITC-positive macropinosomes is similar to that performed for the

in vitro staining. Because each individual intratumoral dextran injection leads to varying

degrees of labeling and background fluorescence, the threshold value to be applied to each

tumor is unique and applied to all the images that originate from that single tumor. For the

xenograft tumors, the total particle area and total tumor area are recorded from the ImageJ

analysis and tabulated as shown in Table 3. For simplicity, we multiply the “Field Index”

values by 100. To successfully employ this protocol for xenograft tumors, we recommend

analyzing at least 300 cells, which typically consists of 5–10 fields/section from 3–5 frozen

sections. The macropinocytic index values for xenograft tumors typically range from 0 to

0.5 for low macropinocytic tumors and are >1 for highly macropinocytic tumors. These

values can vary by up to 30% from experiment to experiment, which can be improved by

increasing the sample size, and we typically observe an average variation between 10–20%

from experiment to experiment. When analyzing xenograft tumors derived from several

different cancer cell lines or when employing different conditions, the macropinocytic index

can be displayed graphically using the raw or relative values.
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Figure 1. Representative images typically obtained from an in vitro macropinocytosis assay
The cells utilized in this particular assay were MIA PaCa-2 (top panel) and BxPC-3 (bottom

panel). Nuclei are labeled with DAPI. A phase contrast image is used to determine the area

of the field covered by cells. Fluorescent images captured in the rhodamine channel show

the TMR-dextran-positive macropinocytic puncta for each field. For display purposes only,

the TMR-dextran images were adjusted for brightness and contrast via ImageJ by selecting

the B&C auto function. This adjustment does not affect the subsequent thresholding of the

images. To determine the threshold value to be applied to all the images, the MIA PaCa-2

image was utilized. Based on this image, a threshold of 133 (on a dark background) was

applied to all the images. Prior to accepting the threshold value, ImageJ depicts the detected

macropinosomes in red (Set Threshold). Once accepted, the image is converted to a binary

image in which the macropinosomes are shown in black on a white background (Binary

Image). In the binary image, only particles that fall within the cell-covered area (yellow

outline) contribute to the calculation of the ‘Field Index’. Scale bar represents 20 μm.
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Figure 2. Representative images typically obtained from an in vivo macropinocytosis assay
Tumors used in this assay were derived from MIA PaCa-2 (top panel) or BxPC-3 (bottom

panel) cells. Nuclei are labeled with DAPI. The pancreatic epithelial cells are labeled with

the Troma I antibody, which labels Cytokeratin-8 (CK-8) and areas of the tumor populated

by the CK-8-positive epithelial cells are outlined in yellow. Fluorescent images captured in

the FITC channel show the FITC-dextran-positive macropinocytic puncta for each field. The

CK-8 and FITC-dextran images were automatically adjusted for brightness and contrast via

ImageJ. The automated threshold value was determined for each individual tumor (MIA

PaCa-2 = 378, BxPC-3 = 464) and verified visually. When setting the threshold, ImageJ

depicts the macropinosomes that fall within the threshold setting as red (Set Threshold) and

converts the image to a binary image for quantification (Binary Image). In the binary image,

only particles that fall within the CK-8-positive area (yellow outline) contribute to the

computation of the ‘Field Index’. Appropriate institutional regulatory board permission was

obtained for the animal experiments this data was derived from. Scale bar represents 20 μm.
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Table 1

Step Problem Possible Reason Solution

1.A.iii Lower than anticipated
cell confluency after
initial seeding or after
serum starvation.

Cell line does not adhere
well to uncoated cover
glass or cells die upon
serum starvation.

Coat coverglass with extracellular matrix protein solution or polylysine
and evaluate cell adherence on coated coverglass. Reduce serum
starvation to 1–3 hours, or place cells in reduced serum media instead of
withdrawing serum completely.

3 Automated exposure time
feature yields low signal,
high background preview
with long exposure time
(>2000 ms).

Poor Signal to Noise Ratio:
Dextran uptake levels are
low or dextran signal
intensity is low.

Manually reduce exposure time to 100–1000 ms. If macropinosomes can
be clearly delineated above background use the manually inputted
exposure for subsequent imaging. If little to no macropinosomes are
observed, then the cell line might have low macropinocytosis levels and
should be compared to cell lines known to possess high
macropinocytosis levels as described in the experimental design section.
If known high macropinocytosis cell line(s) yield low signal intensity
macropinosomes then optimization of macropinosome labeling will be
necessary (see TROUBLESHOOTING of Step 6)

6 Very few images contain
bright, discrete
macropinocytic puncta.

Poor Signal to Noise Ratio:
Dextran signal intensity is
low or background noise is
too high.

If high background is observed, ensure complete washing steps (see
steps 1.A.v or 2.B.iii) are performed or add additional PBS washes to
reduce non-specific background. An additional low pH buffered wash
step may diminish surface bound dextran29. Alternatively, reduce the
concentration of dextran used. Note that lowering the dextran
concentration will also reduce dextran signal intensity in
macropinosomes. If low dextran signal intensity in macropinosomes is
observed even in known high macropinocytosis cell lines the following
may improve results: (i) increase concentration of dextran used for
labeling macropinosomes (ii) ensure dextran properly reconstituted or
make new dextran stock solution (iii) increase time of dextran uptake.
Note that fluorescently labeled fixable dextrans from other sources than
those listed in materials section might contain less fluorescent dye
molecules per dextran, thus yielding less signal intensity.

6 Dextran aggregates are
present in images that are
greater in size than
macropinosomes (>10
μm).

Dextran Stock Solution not
properly reconstituted or
insufficient washes post
macropinosome labeling.

Ensure that dextran stock solution is properly reconstituted. If problem
still occurs see washing steps above for problems with high background.
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